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Chapter 1 Overview

Introduction
This document describes the changes implemented in Genesis software 
version 10.0 as compared to the last major version 9.9b. This version 
requires the gene100 license.

Identification
The get process version number for all platforms is 10.0

Intended Readers
All Genesis users.

Organization of this Manual
Chapter One, Overview - introduces the subject of release notes.

Chapter Two, Highlights - describes in brief the changes in this version.

Chapter Three, Major Enhancements - Lists major changes and 
enhancements made to Genesis in this version. 

Chapter Four, Enhanced Analysis and DFM Actions - Describes 
major enhancements and improvements introduced in this version to 
existing Analysis and DFM Actions.

Chapter Five, Minor Enhancements  - Lists minor changes and 
enhancements made in this version of Genesis. 

Chapter Six, Parameters, Attributes, and Commands - Lists changes 
and additions to configuration parameters, system attributes, and line 
mode commands.

Chapter Seven, KIT List - Lists KIT bugs and requests that have been 
closed.

Read More
For comprehensive information about previous versions of Genesis, go to: 
http://www.frontline-pcb.com/category/Genesis2000_Version
091000113 Release Notes Version 10.0 5
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Chapter 2 Highlights

System

New Job Backup Tool
The new Genesis Backup tool enables you to backup jobs on a network 
repository and restore them when you need them. Among other benefits, 
this enables you to keep several versions of the same job.

For more information, see “New Backup Tool” on page 8.

New Resize Algorithm
A new algorithm for the Resize operation was introduced in Version 10.0 
that eliminates all unexpected behaviors that may occur during Resize 
operations. It also improves Fill and Pattern Fill operations.

For more information, see “New Resize Algorithm” on page 13.

Sync Material Panels from InPlanFlex to Genesis via 
InLink

You can now sync material panels defined by InPlanFlex® to Genesis. 
You no longer need to create panel information separately in Genesis —
merely import the information, via InLink, from InPlanFlex to Genesis.

For more information, see “Sync Material Panels from InPlanFlex to 
Genesis via InLink” on page 12.

I/O

Support Enabled for IPC2581A Input Format
As of version 10, Genesis can support input in the new IPC2581A format. 
This is a licensed option - it requires the inp2581 license. Data input is 
carried out through the standard Import Job function.

For more information, see “Support for Input of New IPC2581A Format” 
on page 13.
091000113 Release Notes Version 10.0 6
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Graphic Editor

New Spacing Repair Tool
The Interactive Spacing Editor enables you to define spacing 
requirements between two selected features at the start of the editing 
process, and provides the tools necessary to change one or both features in 
order to obtain the desired spacing. 

For more information, see “Interactive Spacing Repair Editor” on page 13.

DFM and Analysis Actions

Wrong Compensation Reported in Rout Layer Checks
Wrong compensation for chains is now detected and reported in Rout 
Layer Checks. The most typical reason for wrong compensation is a hole 
in the chain. Such chains are now reported in the new category Wrong 
Compensation.

Fore more information, see “Enhancements to Rout Layer Checks” on 
page 18.

Detect Critical Traces by Board Net added to Critical 
Traces Detection DFM

The Critical Trace Detection DFM was enhanced with the optional ability 
to detect critical traces by board net. This new capability can reduce the 
number of critical traces as many nets are connected on the board net level.

For more information, see “Detect Critical Traces by Board Net added to 
Critical Trace Detection” on page 21.
091000113 Release Notes Version 10.0 7
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Chapter 3 Major Enhancements

 System

New Backup Tool
The new Genesis Backup tool enables you to backup jobs on a network 
repository and restore them when you need them. Among other benefits, 
this enables you to keep several versions of the same job.

The Backup and Restore functions are part of the File menu in the 
Engineering Toolkit. 

Note You can also use the Job Repair utility to verify job integrity 
before backing up the job.
091000113 Release Notes Version 10.0 8
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Backup Procedure
In the Engineering Toolkit, click File > Backup/Restore > Backup to 
open the Backup Jobs Popup.

 

• Click Jobs to open the Jobs Popup. Select which jobs to backup. 

• Click Repository to select the data repository where the job backup 
data will be sent. 

If you have not yet defined a backup data repository, an error message 
appears telling you to define the path to the repository.

Click Backup to begin the job backup process. 
091000113 Release Notes Version 10.0 9
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Restore Process
In the Engineering Toolkit, click File > Backup/Restore > Restore to 
open the Backup Repository Management Popup.

 

Here you can select the jobs to be restored or deleted. You can filter your 
selection according to a number of different criteria:

• Genesis user name

• Customer name

• Data Repository name

• Date when job was last accessed, backed up, or created

• User-designed custom filter created with the same methods used to 
create job filters in the Genesis clipboard.(See Doc. 102, Engineering 
Toolkit, for more information on creating job filters.)

Once the list of jobs appears in the display area, you can select only those 
jobs that require further processing. 

• Select the desired jobs by clicking on the job name. 

• Select multiple jobs by holding down the CTRL key and then clicking 
on the job names desired. 

You may Select All jobs that appear in the list by clicking the appropriate 
button. Or you may clear the list and start over by clicking Clear All.

Creating a Backup Repository

To create a backup repository:

1. Create a folder in which you will place the configuration and setup files. 
Example: C:\genesis\backup.

2. Define a new environment variable, FRONTLINE_BACKUP_DIR, and 
then add the path to the backup folder in the variable definition.

3. Inside the backup folder indicated by FRONTLINE_BACKUP_DIR, 
insert two new text files bakdblist and bakconfig. Update them according 
to the instructions below.
091000113 Release Notes Version 10.0 10
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• bakdblist: Repository listing

Define the repositories to be used by the system. Each repository is 
just a folder. For each repository, define in bakdblist the following 
settings:  

• bakconfig: Configuration file

Add the following configuration variables:  

4. In FRONTLINE_BACKUP_DIR, create an empty file called 
bakjoblist. In this file the system records all jobs that will be backed up.

File Locking Mechanism for Job Backup Repository
This section describes the locking mechanism used by the Job Backup 
Repository to manage shared resources.

Note This information is intended primarily for system administrators.

Implementation
A lock directory is created in $FRONTLINE_BACKUP_DIR. 

A lock is represented by a file named 
<resource name>.<lock type>.<hostname>.<pid>

Example: (bakjoblist.read.england.16282)

The lock file contains the…

• Application name

• Application user name

Interaction of Read and Write Locks
• When locking resource R for reading, the application verifies that no 

write locks exist for resource R. 

DBS { 

NAME=rep_1 Repository Name

WINPATH=c:/genesis/backup/rep_1 Path - for Windows users 

NFSPATH= Path for Unix users

READ_ONLY=no 
}

Flag whether this is read 
only repository

REPOSITORY_NAME=myrepository Define the default 
repository to be used

DEL_AFTER_BACKUP=no Whether to delete job 
after backup 

BACKUP_BY_CHECKIN=no Currently not in use 

LOCK_WAIT=5 How long to wait before 
ignoring a lock 
091000113 Release Notes Version 10.0 11
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• When locking resource R for writing, the application verifies that no 
read locks or write locks exist for R.

Waiting for a Lock
A configuration variable in the backup database configuration file 
determines how many seconds the application will wait before 
determining that the locking/unlocking operation has failed. The 
configuration variable is named LOCK_WAIT. It is measured in seconds 
and has a default value of 5.

Note The "lock access" file is an empty file with the name 
superlock,write,<hostname>,<pid>. This superlock file 
should exist only when file locking or unlocking operations are 
occurring.

Sync Material Panels from InPlanFlex to Genesis via 
InLink

You can now sync material panels defined by InPlanFlex® to Genesis. 
You no longer need to create panel information separately in Genesis —
merely import the information, via InLink, from InPlanFlex to Genesis.

To access the InLink Popup, select Actions > InLink > Sync data from 
the Engineering Toolkit main menu.

 

Note This requires using InPlanFlex® V3.20. If you try syncing a 
material panel from a schema that is related to an earlier version, 
you will receive an error that there is no such database object. 

Note The Panel option will sync the InPlan main panel according to 
the methods used in previous versions.
091000113 Release Notes Version 10.0 12
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New Resize Algorithm
A new algorithm for the Resize operation, introduced in Version 10.0, 
eliminates all unexpected behaviors that may occur during Resize 
operations. It also improves Fill and Pattern Fill operations.

 I/O

Support for Input of New IPC2581A Format
As of version 10, Genesis can support input in the new IPC2581A format. 
This is a licensed option - it requires the inp2581 license. Data input is 
carried out through the standard Import Job function.

Disclaimer

This input was tested only on the sample data provided by the 
IPC2581 consortium. Frontline recommends at this stage to ask 
customers to send reference data (ODB++ or RS274X) to validate the 
input.

 Graphic Editor

Interactive Spacing Repair Editor

Introduction
The Interactive Spacing Editor enables you to define spacing 
requirements between two selected features at the start of the editing 
process, and provides the tools necessary to change one or both features in 
order to obtain the desired spacing. 

Note If the two selected features touch each other, definition of spacing 
requirements cannot be performed. 

There is often a need to resolve interactively spacing problems between 
board features. The features could be on the same layer (copper2copper, 
clearance2clearance) or on different layers (clearance2copper, 
drill2copper, rout2copper). Genesis provides a number of DFM actions to 
resolve spacing difficulties, but these DFM actions cannot solve ALL 
possible spacing problems, as it would be far too complicated to define 
rules that would cover every possible spacing repair problem. A better 
solution would be to create automatic DFM actions to solve the majority 
of definable spacing problems, and use an interactive tool to repair the 
more complex, or less obvious, problems. 

Existing Genesis repair tools enable you to move and stretch different 
features on a board, but none of these tools enables you to define the 
spacing required between features as a starting point of the editing 
091000113 Release Notes Version 10.0 13
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process. The Interactive Spacing Editor enables you to define, at the 
start, spacing requirements between two selected features, and then 
provides the tools necessary to change one or both features in order to 
obtain the desired spacing. 

Specific repair methods are defined for each feature. You can select which 
repairs to apply to either or both selected features, and define the extent of 
repairs required for either or both features. 

Repair Processes and Tools
Interactive spacing repair can be carried out on the following features:

• Square or rectangular pad

• Any other pad

• Line (round)

• Surface

After selecting the features for which spacing problems are to be repaired, 
the following information is displayed:

• Actual spacing between selected features

• Feature parameters (See table below)

• Feature layer name 

 

A number of spacing repair tools and procedures are available.

 

Features Parameters Example

Round pad <symbol name> Pad: r2000

Square pad <symbol name> Square Pad: s2000

Other pad <Special symbol name> rect2000x1000

Line <symbol name>  (line length) Line: r500 (12mm)

Surface Surface

Repair Action Process

Shave Add a negative shave (line or surface) on the feature

Shrink Resize the pad or the surface feature (decrease in all 
directions) and create a new symbol

Subtract The line will be broken and a new thin line will be added

Shift Move the surface or the pad

Move triplet Move a triplet for the line

Reshape Decrease size in one direction only (create new special 
symbol)

Reshape & Shift Decrease size in one direction only (create new special 
symbol and shift the pad coordinate)
091000113 Release Notes Version 10.0 14
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Using the Interactive Spacing Editor

To use the Interactive Spacing Editor:

• Select Edit > Change > Spacing Repair from the main menu.

The Spacing Repair Popup appears. 
 

1. Select the two features which need spacing repair.

a. Click the icon for the feature to be selected. In the Graphic Editor, 
select the feature by clicking on it. Information describing the feature 
and possible repair methods will appear in the popup.

b. Repeat the process for the second feature.

2. Define the required spacing by entering a value in the Desired field.

Square Pad Shave, Shrink, Shift pad, Reshape

Rectangle Pad Reshape & Shift

Re-route Create triplet

Repair Action Process

Spacing Shift Slider
091000113 Release Notes Version 10.0 15
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3. Select the repair method to be used on each feature.

The repair method to be used is dependent on feature type. The popup 
displays a list of repair methods available for each of the selected 
features. 

 

If the repair method is defined, the actual repair is previewed on one or 
both features, depending on what was selected. 

4. You can move the "Spacing Shift" slider to define which part of the 
additional space will be obtained from the first or the second feature. For 
example: 60% from the 1st feature and 40% from the 2nd one.

5. As you move the slider, the repairs are previewed online.

6. When you are satisfied with the new spacing as previewed, double-click to 
execute, or click OK or Apply on the Spacing Repair Popup.

Remarks • Shaving may be executed by using a Line or Surface, depending on 
the options selected. 

• If Shave By Line is selected and the features are on the same layer, 
shaving may be carried out by a single line for both features.

• Reshaping will be carried out using a subtractive shave, resulting in 
positive data only. (All pads become special symbol pads; surface 
vertices will be re-routed.)

• Reshape & Shift is implemented for rectangular pads only. 
For example: a pad rect60x40, reduced in size from one side by 5 mils, 
will be replaced by a pad rect55x40, and shifted 2.5 mils. 

• Move Triplet is permitted only if the selected line is part of a triplet 
(actually, the center section of the triplet). Therefore, Move Triplet 
should be used only when this condition is true. The Move Triplet 
option is always "Keep Angle".

Note Spacing repairs are implemented by the new line mode command 
space_edit. For more information, see “space_edit” on page 44.

Feature type Repair method

Square Pad 
Rectangle Pad

Shave, Shrink, Shift pad, Reshape, Reshape & 
Shift

Any other pad Shave, Shrink, Shift pad or pad-stack, Reshape

Round Line Shave, Subtract, Move triplet, Reroute locally

Surface Shave, Shrink, Shift, Reshape
091000113 Release Notes Version 10.0 16
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Examples  

 

Shave by single line Shave by separate lines

Shave by surface and shift pad Subtract Line

Move triplet Reroute Line
091000113 Release Notes Version 10.0 17
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 Doc. 0503 - Analysis Actions

Enhancements to Rout Layer Checks

Detect Wrong Compensation for Chains
Wrong compensation for chains (compensation is implemented from the 
wrong side of the board edge) is now detected and reported in Rout Layer 
Checks. The usual reason for wrong compensation to occur is a hole in the 
chain. Such chains are now reported in the new category Wrong 
Compensation.

Wrong Compensation

Item Details

Full Name Wrong Compensation

Internal ERF Name wrong_compensation

Measurement Shape Limits

Measurement ID(s) Rout chain, surface

Layers Displayed Rout layer
091000113 Release Notes Version 10.0 18
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Purpose Warns about chaining errors which might damage the board.

Function Reports rout compensation which goes in the wrong direction.

Activation Check is activated automatically when the analysis is run. No need 
for special settings for activation.

Known Limitations Surface and chain with hole in it will be processed.

Item Details
091000113 Release Notes Version 10.0 19
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Report Remaining Residue in Rout Layers Checks
Rout Checks can now report the limits of board residue left after routing. 
This is residue which should have been cut from the PCB, but remains 
because the routing knife bends at corners and does not reach the 
remaining residue trapped in the corners. These residue limits are reported 
in the new category Residue.

Note Only chains with both holes and surfaces will be processed.

Residue

Item Details

Full Name Residue

Internal ERF Name residue

Measurement Shape Limits

Measurement ID(s) Rout chain, surface

Layers Displayed Rout layer

Purpose Warns about the residue caused by the routing knife bending in 
corners.

Function Reports rout residue, usually in corners.

Activation Check is activated automatically when analysis is run. No need for 
special settings for activation.

Known Limitations None
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 Doc. 0602 - DFM Actions

Detect Critical Traces by Board Net added to Critical Trace 
Detection

The Critical Trace Detection DFM was enhanced with the optional ability 
to detect critical traces according to board net. This new capability can 
reduce the number of critical traces detected, as many nets are connected 
on the board net level.

To implement this option, set Consider Board Net = Yes.

The connection to the board net is made when any two different layer nets 
connect through a drill to a single layer net on another layer.

 

Because there are two connectors (drills) between the layers, what 
would be a critical trace (i.e. creates an open) on the layer level is not a 
critical trace (i.e. does not create an open) on the board level.
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Chapter 5 Minor Enhancements 

 Graphic Editor

Special Symbols can be Rotated
As of version 10.0, Genesis special symbols can be rotated. Prior to 
version 10.0, such symbols could not be rotated.

Prefix Option Enabled for Multi Layer Copy
It is now possible to add a prefix, as well as a suffix, to the layer names of 
new layers created when copying existing layers using Multi Layer 
Copy. The new Prefix options operates in the same manner as the Suffix 
field, except that it adds a prefix instead of a suffix to target layer names.
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Configurable Width for Step Name Column in S&R Table
The new configuration parameter edt_sr_name_col_width enables you to 
specify the display width of the column that shows the Step name in the 
Step & Repeat Table Popup. The column display width may be defined 
from 12 to 64 characters wide (default=12). 

If edt_sr_name_col_width = 0, the column width display will be 
equal to the number of characters used in the longest Step name found 
in the S&R table (but never less than 12).

 

For more information, see “edt_sr_name_col_width” on page 40.
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New Arc Length Parameter for Advanced Filter Popup
A new Arc Length parameter was added to the Advanced Filter Popup. 
This new parameter enables you to filter arcs for display according to their 
length. You can specify minimum and maximum arc lengths. 

 

Two additional parameters, min_arc_len and max_arc_len, were added 
to the line mode command adv_filter_set. 

Example adv_filter_set, filter_name=popup, update_popup=yes, 
arc_values=yes, min_sweep_angle=0, max_sweep_angle=0, 
min_diameter=0, max_diameter=0, min_arc_len=40, 
max_arc_len=80

For more information, see “adv_filter_set” on page 45.

Outline Polarity Option Added to Feature to Outline Popup
A new Outline Polarity parameter was added to the Feature to Outline 
Popup. This new parameter enables you to define the polarity for outlines 
created from features. 

Available options include:

• As feature: Outline will have the same polarity as the original feature.

• Positive: Positive outline will be created.
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• Negative: Negative outline will be created.

 

The new parameter polarity was added to the line mode commands 
sel_feat2outline and sel_feat2outline_partial. 
Options for polarity:[as_feature; positive; negative].

For more information, see “sel_feat2outline” on page 46.

Selection or Buffer Options: Access Default Settings 
Without Opening Control Popup

As of version 10, Genesis will access saved default selection or buffering 
options without the need for you to first open the appropriate popup 
(Selection Options Popup or Buffer Options Popup). This is accomplished 
by setting the new configuration parameter edt_consider_saved_defaults 
to Yes. 
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If edt_consider_saved_defaults = No, Genesis will maintain its earlier 
behavior, and not access the saved default values until the appropriate 
popup has been opened. See “edt_consider_saved_defaults” on page 40.

 

Explanation Genesis enables you to save user-defined default feature selection options 
or buffering options made in the Selection Options Popup or Buffer 
Options Popup by pressing <CTRL+ALT+S> on the keyboard. (There is 
no equivalent GUI command.) With this new configuration parameter, 
Genesis can use those default selection or buffering options without first 
opening the appropriate popup. 
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 I/O

Enhancements to Sieb & Meyer Output

M97/M98 Command Supported for Canned Text 
Output

Genesis Sieb & Meyer output now supports the M97/M98 command for 
canned text: the text will not be broken during output. This enables the 
user to change text inside the file without the need to output data again. 

T0 Command Added After Last Coordinate of Each 
G45/G46 Command

Genesis Sieb & Meyer output now adds a T0 command after the last 
coordinate of each G45/G46 command.

The ability to add the T0 command is controlled by the new Boolean 
configuration parameter iol_sm_t0_after_full_circle. It has the following 
values:

• Yes (default) - add T0 command after last G45/G46 command 
(routing full circle).

• No - does not add T0 command (maintain old behavior).
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 Analysis/DFM Actions

Enhancements to Drill Checks

Separate Reports for Missing Via Holes in Stacks
As of version 10.0, missing vias in stacks will be reported in a separate 
category named Missing Stacked Via Holes. For this new category to 
appear, the ERF variables v_consider_stacked_via_in_missing_hole 
and v_separate_missing_stacked_via should be set to Yes. 

• When v_consider_stacked_via_in_missing_hole = Yes and 
drill span = 2, missing vias in stacks are reported in the category 
Missing Holes. 

• When the new ERF variable v_separate_missing_stacked_via = 
Yes, missing vias in stacks are reported separately in the new category 
Missing Stacked Via Holes.

New Categories for Close Vias
Six new categories have been added to Drill Checks. These new categories 
enable reporting cases where one via is close to another via, PTH or 
NPTH.
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Close Via2NPTH (isolate)
 

Item Details

Full Name Close Via2NPTH (isolate)

Internal ERF Name close_via2npth_isolate

Measurement Shape Segment

Measurement ID(s) Pad

Layers Displayed Drill layer

Purpose
Function Report the spacing of Via hole to NPTH which are in different nets.

Activation
Known Limitations
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Close Via2NPTH (conn) 

Close Via2Via - Same Net  

Close Via2Via - Different Net
 

Item Details

Full Name Close Via2NPTH (conn)

Internal ERF Name close_via2npth_conn

Measurement Shape Segment

Measurement ID(s) Pad

Layers Displayed Drill layer

Purpose
Function Report the spacing of Via hole to NPTH which are in the same net.

Activation
Known Limitations

Item Details

Full Name Close Via2Via - Same Net

Internal ERF Name close_via_same_net

Measurement Shape Segment

Measurement ID(s) Pad

Layers Displayed Drill layer

Purpose
Function Report the spacing of Via holes which are in the same net.

Activation
Known Limitations

Item Details

Full Name Close Via2Via - Different Net

Internal ERF Name close_via_diff_net

Measurement Shape Segment

Measurement ID(s) Pad

Layers Displayed Drill layer

Purpose
Function Report the spacing of Via holes which are in different nets.

Activation
Known Limitations
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Close Via2PTH - Same Net
 

Close Via2PTH - Different Net
 

Item Details

Full Name Close Via2PTH - Same Net

Internal ERF Name close_pth_same_net

Measurement Shape Segment

Measurement ID(s) Pad

Layers Displayed Drill layer

Purpose
Function Report the spacing of Via hole to PTH which are in the same net.

Activation
Known Limitations

Item Details

Full Name Close Via2PTH - Different Net

Internal ERF Name close_pth_diff_net

Measurement Shape Segment

Measurement ID(s) Pad

Layers Displayed Drill layer

Purpose
Function Report the spacing of Via hole to PTH which are in different nets.

Activation
Known Limitations
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Enhancement to Signal Layer Checks

Report Features Built with Zero-width Special Symbols
An enhancement was made to the category Zero Width or Too Thin 
Features in the Signal Layer Checks Analysis Action. Prior to version 10, 
this category reported only Pads that were drawn using zero-width R0 or 
S0 symbols. As of version 10, this category also reports Pads drawn with 
zero-width special symbols. These features will not appear on the final 
plot. 

If v_report_zero_width_features = Yes, all features whose width is 
zero (drawn with zero-width R0 or S0 symbols, or zero-width special 
symbols), or features that are not larger than the value of ERF variable 
v_max_width_for_too_thin_features, are reported in the category 
Zero Width or Too Thin Features.

If v_report_zero_width_features = No, Signal Layer Checks does 
not report these features.

Enhanced Category: Zero Width or Too Thin Features
 

Item Details

Full Name Zero Width or Too Thin Features

Internal ERF Name zero_width

Measurement Shape Shape of features or special symbols whose width is 0 or not 
larger than ERF variable v_max_width_for_too_thin_features

Measurement ID(s) None

Layers Displayed Work layer
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Enhancement to Solder Mask Checks

Report Features Built with Zero-width Special Symbols
An enhancement was made to the category Zero Width or Too Thin 
Features in the Solder Mask Checks Analysis Action. Prior to version 10, 
this category reported only Pads that were drawn using zero-width R0 or 
S0 symbols. As of version 10, this category also reports Pads drawn with 
zero-width special symbols. These features will not appear on the final 
plot. 

If v_report_zero_width_features = Yes, all features whose width is 
zero (drawn with zero-width R0 or S0 symbols, or zero-width special 
symbols), or features that are not larger than the value of ERF variable 

 

Purpose Reports all features whose width is zero (drawn with zero-width R0 
or S0 symbols, or zero-width special symbols) or features that are 
not larger than the value of ERF variable 
v_max_width_for_too_thin_features. These features will not 
appear on the final plot.

Function Reports all features and special symbols whose width is zero 
(drawn with symbols R0 or S0, or with zero-width special symbols) 
or features not larger than v_max_width_for_too_thin_features.

Activation Set v_report_zero_width_features to yes.

Known Limitations v_max_width_for_too_thin_features should not be less than 0 
and not larger than 1 mil.

Item Details
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v_max_width_for_too_thin_features, are reported in the category 
Zero Width or Too Thin Features.

If v_report_zero_width_features = No, Solder Mask Checks does 
not report these features.

Enhanced Category: Zero Width or Too Thin Features
 

Item Details

Full Name Zero Width or Too Thin Features

Internal ERF Name zero_width

Measurement Shape Shape of features or special symbols whose width is 0 or not 
larger than ERF variable v_max_width_for_too_thin_features

Measurement ID(s) None

Layers Displayed Work layer

 

Purpose Reports all features whose width is zero (drawn with zero-width R0 
or S0 symbols, or zero-width special symbols) or features that are 
not larger than the value of ERF variable 
v_max_width_for_too_thin_features. These features will not 
appear on the final plot.

Function Reports all features and special symbols whose width is zero 
(drawn with symbols R0 or S0, or with zero-width special symbols) 
or features not larger than v_max_width_for_too_thin_features.

Activation Set v_report_zero_width_features to yes.

Known Limitations v_max_width_for_too_thin_features should not be less than 0 
and not larger than 1 mil.
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Enhancement to Sliver Repair
The Sliver Repair algorithm was enhanced to enable repairs of all slivers 
in negative power & ground layers.

The Sliver Repair action can now repair slivers or peelables in negative 
power & ground layers which are not larger than max sliver value or max 
peelable value. Prior to this enhancement, the action could repair slivers 
or peelables to the size of 2 * max sliver value or 2 * max peelable value.

 

Enhancement to Drill Touching Copper Count
In DTCC, category titles can be created dynamically by using the drill size 
as part of the category name. As of version 10.0, dynamically-created 
category names that use the drill size will display the correct and complete 
drill size, including the numbers appearing to the right of the decimal point 
(if they exist in the actual data). Prior to version 10.0, the drill size in the 
category name was rounded, with the digits after the decimal point not 
appearing.

 

Category titles before 
version 10.0
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Note This enhancement is relevant only when working in Metric units. 
It is not relevant when working with Imperial units.

Enhancement to Solder Mask Repair

Rules for Treatment of Coverage Problems
A new ERF variable, v_max_edge_overlap_for_coverage, was added to 
the Solder Mask Repair DFM Action. This new ERF variable is designed 
to help decide when to fix certain coverage problems. 

 

General Rules for Repair

• If the pad is a fiducial, then the coverage problem shown above should 
not be repaired. 

• If the pad is an SMD or drilled pad, than the coverage problem 
described above should be repaired. 

• If the pad is not a fiducial pad, not an SMD pad, and not a drilled pad, 
then the decision whether or not to repair such coverage problems is 
decided by the value of the new ERF variable 
v_max_edge_overlap_for_coverage.

Defines the maximum permitted percentage of edge overlap for 
oversized clearances for which the Solder Mask Repair action 
will repair the coverage problem. If the copper overlap clearance 

Category titles as of version 10.0. 
Note the numbers (.98,.20) appearing after the decimal point.
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edge is larger than this value, the Solder Mask Repair action will 
not repair the coverage problem, but merely report it. 

The default value is -1. This value tells the system not to consider 
the overlap percentage, and to always try to fix such coverage 
problems.

Enhancement to Advanced Teardrops Creation
As of version 10.0, you can specify whether to add teardrops to drilled 
pads, undrilled pads, or to both types of pad. 

Drilled pad: If the distance between a pad center and a drill center is 
less then 0.1 mils, the pad is counted as a drilled pad.

Undrilled pad: If the distance between a pad center and a drill center 
is more then 0.1 mils, of if a pad does not touch a drill at all, then the 
pad is considered an undrilled pad. 

 

The pad and drill 
on the right-hand 
side not only 
touch, they have 
the same center 
(their centers are 
separated by less 
than 0.1 mil). This 
pad is considered 
a drilled pad.

The pad on the 
left-hand side 
touches the drill, 
but does not 
share the drill 
center (their 
centers are 
separated by 
more than 0.1 
mil). This pad is 
considered an 
undrilled pad.
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Examples • Create teardrop for drilled pads only. 

• Create teardrop for undrilled pads only.

• Both types of pad (drilled and undrilled pads) get a teardrop.
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Chapter 6 Parameters, Attributes, and 
Commands

New Configuration Parameters
 

 

 

edt_consider_saved_defaults
Type Boolean

Default No

Description Consider saved Selection & Buffer default values
Enables use of saved default values for Selection options and Buffer options 
without needing to reopen the Selection Options Popup or the Buffer Options 
Popup.

See Also The Graphic Editor (Doc. 0601)

edt_sr_name_col_width
Type Integer

Default 12

Description Sets the column width for the Step column in the Step & Repeat Table. 
Range is 12 to 64.
If edt_sr_name_col_width = 0, the column width display will be equal to the 
number of characters used in the longest step name found in the S&R table 
(but never less than 12).

See Also The Graphic Editor (Doc. 0601)

iol_sm_t0_after_full_circle
Type Boolean

Default Yes

Description Enables adding a T0 command after the last G45/G46 command.
Yes (default) - add T0 command after last G45/G46 command (routing full 
circle).
No - does not add T0 command (maintain old behavior).

See Also Output Formats (Doc. 0702)
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New Line Mode Commands

Backup/Restore Job Line Mode Commands

backup_job_list  

backup_job_properties  

backup_job_delete  

Command
backup_job_list

Group
Engineering Toolkit

Description
Builds a backup repository job list in a file containing lines of <job_name> <job_ver>

Response
None

Parameter  Value

path Path to report

Command
backup_job_properties

Group
Engineering Toolkit

Description
Builds a backup repository job list in a file containing lines of <job_name> <job_ver>

Response
Job properties in the following order:
 <job_name> <ver> <repository_name> <date> <time> <format> <application> <oper> 
<customer>

Parameter  Value

job Job name

ver Job version number (or 0 for last job version)

Command
backup_job_delete

Group
Engineering Toolkit

Description
Deletes a job from a backup repository

Response
None

Parameter  Value

job Job name
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backup_job_backup  

backup_job_restore  

backup_job_tool_open  

ver Job version number (or 0 for last job version)

date_time (Optional) Date and Time when job was backed up. Parameter has the following format:
dd-MMM-yy HH:mm:ss (Leading zeroes required). Example: 02-Jul-12 09:35:03
Note: date_time overrides ver

Command
backup_job_backup

Group
Engineering Toolkit

Description
Backup a job from the application database to a backup repository

Response
None

Parameter  Value

repo Name of target job repository

job Name of job to back up

mode Method of storing job in repository: directory, tar, tar_gzip

Command
backup_job_restore

Group
Engineering Toolkit

Description
Restores a job from backup repository to the application database

Response
None

Parameter  Value

job Job name

ver Job version number (or 0 for last job version)

date_time (Optional) Date and Time when job was backed up. Parameter has the following format:
dd-MMM-yy HH:mm:ss (Leading zeroes required). Example: 02-Jul-12 09:35:03
Note: date_time overrides ver

dest_job New name for restored job

dest_db Name of destination job database

Command
backup_job_tool_open

Group
Engineering Toolkit
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restore_job_tool_open 

backup_job_tool_close 

restore_job_tool_close 

Description
Opens the job backup window

Response
None

Parameter  Value

jobs List of job names. Names separated by semicolons (;).

Command
restore_job_tool_open

Group
Engineering Toolkit

Description
Opens the job restore window

Response
None

Command
backup_job_tool_close

Group
Engineering Toolkit

Description
Closes the job backup window

Response
None

Command
restore_job_tool_close

Group
Engineering Toolkit

Description
Closes the job restore window

Response
None
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Other Commands

space_edit 

Command
space_edit

Group
Graphic Editor

Description
Change or create space between two features    
Features may be on the same or different layers

Parameter  Value

fidx1 First feature index.  Use existing feature index

fidx2 Second feature index.  Use existing feature index

layer1 First feature layer name.  Use existing layer name

layer2 Second feature layer name.  Use existing layer name

mode1 First feature repair mode

mode2 Second feature repair mode

common_
shave

In cases that use the shave mode for both features on the same layer: 
- yes - use a single line to shave both feature
- no  - use two line to shave each feature

space Desired spacing between first and second features. 
Range:  [>0 .. 100] mil (in current units)   

shift Shift space from the middle of the space from the first to the second feature.
Used if mode1 & mode2 != none. Range: [-50 .. +50] mil (in current units).
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Revised Line Mode Commands

adv_filter_set
The new parameters min_arc_len and max_arc_len were added to the 
existing LMC adv_filter_set.

 

copy_layer
The value new_layers_only was added to the parameter copy_attrs in the 
existing LMC copy_layer.

Command
adv_filter_set

Group
Graphic Editor

Description
The command is used for setting the advanced 
Features filter parameters. The filter is used for 
various functions, such as 'features selection'. 

New Parameter Description

min_arc_len
max_arc_len

Minimum and maximum arc length 
Value: [>=0] (inch/mm)

Command
copy_layer

Group
Graphic Editor

Description
The command copies a layer to another layer. If 
the destination layer does not exist, it will be 
created and added to end of the matrix.

Parameter Description

copy_attrs Defines whether to copy layer attributes when 
layer features are copied.
Values:
- No (default) - Do not copy layer attributes
- Yes - Copy layer attributes
- New layer only - Copy new layers only
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print
A new parameter was added to the existing LMC print.

 

sel_feat2outline
The value parameter polarity was added to the existing LMC 
sel_feat2outline.

sel_feat2outline_partial
The value parameter polarity was added to the existing LMC 
sel_feat2outline_partial.

Command
print

Group
Graphic Editor

Description
The command is used for printing graphic layers 
in PDF or Postscript format.

New Parameter Description

paper_units Enables custom paper sizes to be defined in 
either inches or millimeters. 
Permitted values: inch, mm. Default = inch.

Command
sel_feat2outline

Group
Graphic Editor

Description
Replace all selected features by line and arc 
features of the selected features outlines. 

Parameter Description

polarity Outline polarity: as_feature, positive, negative

Command
sel_feat2outline_partial

Group
Graphic Editor

Description
Create a feature outline (line and arc features) 
and save only part of the features outline. 

Parameter Description

polarity Outline polarity: as_feature, positive, negative
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Chapter 7 KIT List

The following KITs have been resolved for Genesis version 10.

Note KITs marked with '**' are partially fixed.

KIT No. Priority Description

DFM Actions
17752 C SMR removes large clearance

17580 H Solder Mask Repair erf 
v_max_oversized_clearance

17624 H Signal layer optimization occurred spacing 
violation

17786 H Sliver removal in pg layer

17828 H Embedded SM opening missing in SMR

17902 H Sliver repair problem

17964 H Advanced Teardrop Creation: can not add 
teardrop in v99

17999 H SLO: checklist stop running problem

Analysis Actions
16287 C v_consider_board_net setting problem in SLC

17863 C SLC fail

16276 H Separate stack via missing hole from "Missing 
hole" category

17130 H SLC - get wrong AR when 
v_use_line_width_as_tool_size = no

17713 H False alarm in 'short arc' of 'Rout Analysis'

17714 H Rout analysis should report a corner when 
tool size = arc diameter

17973 H cannot run SLC

17683 M Drill check---wish add item for same net close 
vias

16908 M Rout analysis - alert corners

Input
17247 C ODB & Gerber Discrepancy Analysis

17837 C Gerber274x input problem--SIP is fixed wrong 
with v9.9b

17881 C Input RS274X problem (Surface)

Priority Codes: C Critical, H High, M Medium, L Low
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17913 C Input: Wrong image in Gerber 274x input

17945 C Gerber274x input missing hole

15391 H A little piece of copper is disappearing during 
DPF input

17925 H SIP input fail and genesis crash at v99b1

Output
17810 C Surface not filled properly during output

17822 C Missing surface features on OPFX output

17961 C Drill output does not work

17859 H Rs274x output - should not decompose surface

17651 M Print: features are transparency printed with 
parameter "Print layers=Separately"

Dynamic Etch Compensation
17985 C DETCH time too long

17540 H Request that attributes remain the same after 
DEC

Panelization
17781 M Full step name display in S&R table

Graphic Editor
14144 C Resize surface 1.42 - 1.53mils - bad results

14675 C After resizes, surface disappears. Copper 
removed.

15327 C Some clearances have been disappeared during 
Resize

17556 C Hole disappears during resize

17639 C 2 clearances disappear after resize

17647 C Bad surface after resize

17711 C Resize surface cause data loss

17724 C Global resize closes isolations in surface

17729 C Fill Surface problem

17745 C Resize surface will disappear

17750 C After resizing, some clearance was filled.

17759 C A difference of a resizing result

17803 C Surface fill problem

17804 C Resize surface cause hole missing

17832 C Surface disappeared

17915 C Contourize: Internal error occurred

17127 H The Selection Options are not saved

17485 H Rotate non-standard symbol name problem

KIT No. Priority Description

Priority Codes: C Critical, H High, M Medium, L Low
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17710 H Step Compare issue

17748 H Duplicated donuts changed into a round pad 
during contourization

17801 H Add rotated dynamic text problem

15410 M Corners of clearances become round during 
resize

16110 M Layer Name in the 'S&R Fill Pattern'

16774 M Problem of Resize

17574 M Prefix for multilayer copy

17827 M Length of Arc in Advanced Filter of Feature Filter

System
17883 C Surface is missing after import

17877 H Failure to import a job

Auto Rout Manager
17972 H Auto Rout Manager: scale output arc problem in 

arm

KIT No. Priority Description

Priority Codes: C Critical, H High, M Medium, L Low
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